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FORGE Application Generator for 8000/8300/8400/8500 Series Mobile Computers,
featuring easy-to-use and quick-to-apply, is designed for the users to develop custom
templates for the use with AG runtime preloaded on the mobile computers. Users are
then able to define their own data collection templates on any desktop computer without
spending time writing any program code.

FORGE Application Generator is used to develop applications for many purposes, such
as —

 Receiving in Retail

 Price Check

 Product labeling & Tracking

 Shelf Product Replenishment

 Mobile Point of Sale (POS)

 Mobile Inventory Management

 Order Picking & Staging

 Work-In-Process Tracking

 Material Flow Control

 Transportation & Distribution

 Warehousing

 Asset Management

FORGE Application Generator presents itself as a miniature image of the mobile computer.
It simulates the program’s running sequences on the actual mobile computer, and
therefore, allows you to design a new application on screen in minutes. After having
configured and saved your template, download the application template file and lookup
file(s) to the mobile computer. When running the AG runtime on the mobile computer,
data collection can commence immediately by making use of the template downloaded.

This manual serves to provide comprehensive understanding of FORGE Application
Generator for 8000/8300/8400/8500 Series Mobile Computers, and helps define custom
template for a specific application. We recommend that you read the document
thoroughly before use and keep it at hand for quick reference.

Thank you for choosing CipherLab products!

INTRODUCTION
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FEATURES

 Definition of program flow

 Editing of screens and data

 Managing barcode reader and RFID reader

 Font size options and program localization

 Simple program simulation for debugging

 Password-protected user settings to prevent unauthorized user intervention

 Hot key selection for tasks or user settings’ menus

 Definition of system initial settings for a quick start

 Easy cloning by downloading the template file

 Integrated interface for downloading lookup files and uploading data
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INSTALLING FROM THE PRODUCT CD

Data collection mainly consists of three elements: input (scanning or key-in), data
processing, and output (or updating database). FORGE Application Generator for
8000/8300/8400/8500 Series Mobile Computers is specifically designed to deal with the
sequences of data processing inside the mobile computers.

1) Install FORGE Application Generator for 8000/8300/8400/8500 Series Mobile
Computers from the 7 & 8 Product CD.

If you did not change to install to a different folder, it will install the application to the
default directory “C:\CipherLab\Forge\Batch\”.

 Shortcuts to the AG programs are created and placed in Start > Programs >
CipherLab > Forge > Batch > Application Generator (see table 1 below).

 Shortcuts to the AG utilities are created and placed in Start > Programs >
CipherLab > Forge > Batch > Utility (see table 2 below).

2) Download the AG runtime program (U8*.SHX) and desired font file (.SHX) to the
mobile computer via the “Program Load” utility accessible in Start > Programs >
CipherLab > Forge > Batch > Utility (see table 2 below).

On the mobile computer, press [7] + [9] + [Power] simultaneously to enter System
Menu > Load Program.

Table 1

Shortcut Name of AG Program AG Program Applied to

8 Series Batch AG ForgeAG.exe 8000, 8001, 8020, 8021, 8300, 8400, 8500

Table 2

Shortcut Name of Utility Program Applied to

AG Load AG_Load.exe 8000, 8001, 8020, 8021, 8300, 8400, 8500

Download Lookup DLookup.exe 8000, 8001, 8020, 8021, 8300, 8400, 8500

Data Read Data_Read.exe 8000, 8001, 8020, 8021, 8300, 8400, 8500

Program Load ProgLoad.exe 8000, 8001, 8020, 8021, 8300, 8400, 8500

MobileLink MobileLink.exe 8000, 8001, 8020, 8021, 8300, 8400, 8500

Simulator Simulator.exe 8000, 8001, 8020, 8021, 8300, 8400, 8500

DBFConvert DBF_Converter.exe 8400

Note: You may use the Batch AG program and runtime with any wireless mobile
computer if wireless connectivity is not desired. Especially, when you use a
Bluetooth mobile computer, say 8062 or 8330, you will be able to choose
Bluetooth SPP for download and upload.
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GETTING STARTED

1) Run the ForgeAG program (ForgeAG.exe) on your computer. The ForgeAG UI Frame
pops up and the Command Menu appears as shown below.

Design Application Template

2) Click [Startup] to start with a new or the latest application template.

3) Upon completion, click [File > Save] or [File > Save As] to save the current editing
template to file (*.AGX for 8000/8300/8400/8500) and close the editing window.
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Note: For initial downloading of the application template, you must manually configure the download
settings on the mobile computer. Then, the upload and download settings on the
mobile computer will be overwritten by the settings of the application template
after downloading.

4) Establish a proper connection between your mobile computer and the server.

Download Application Template File

5) Click [Tools > Send Application] to download the template file (*.AGX) to the mobile
computer.

On the mobile computer, select [3. Utilities] > [6. Load Application] to download the
template file. After downloading, the main menu is displayed.

Warning: In the application template file, the upload and download settings for the
mobile computer and PC side must match.

Download Lookup Files

6) If any lookup file is specified in use in the template file, you must download the
lookup file(s). Refer to section 1.4 Lookup (File) and 3 Lookup.

Click [Tools > Send Lookup] to download up to three lookup files for use.
Alternatively, you may use the "DLookup.exe" utility to download text files for
reference purpose.

On the mobile computer, select [3. Utilities] > [8. Load Lookup File] to download the
associated lookup file(s). After downloading, the main menu is displayed.

Collect Data

7) On the mobile computer, select [1. Collect Data] to start with the data collecti on task.

Upload Data

8) Click [Tools > Get File via Direct-Link] or [Tools > Get File via Net] to receive the
collected data (.txt) from the mobile computer.

On the mobile computer, select [2. Upload Data] to send the collected data back to
the server.

 Data file(s)
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 Lookup file(s), if any in use

 All (one by one)

 All (append), that is, all-in-one

Refer to section 1.2.3 Record and 3.3.2 Lookup Data Can Be Uploaded.

If no lookup files are defined on both the Form and Lookup property pages, you may
receive data from the mobile computer via the "Data Read" utility.

Manipulate Data

9) On the mobile computer, select the following submenus if you want to edit the
collected data –

[3. Utilities] > [2. Browse Data]

[3. Utilities] > [3. Delete Data] (Refer to section 5.1.1 Data Deletion.)
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COMMAND BAR

The Command Bar offers the following commands.

Category Command Action…

File New To create a new application template.

Open To open an existing application template. File path
needs to be specified.

Save To save the current editing template.

Save As To save the current editing template to a new file.

Preference To configure the software settings.

Convert to xxxx To convert the AGX Template to different terminal type.

Recent File List To quick launch the recently opened template file.

Exit To close the Application Generator.

Tools Send Program To download the xxx.shx file to the mobile computer.

Send Application To download the current application template to the
mobile computer.

Send Lookup To download associated lookup file(s) to the mobile
computer.

Get File via Direct-Link To receive data via Data-Read utility.

Get File via Net To receive data from the mobile computer via Mobile
Link utility.

Simulator To launch the simulator.

DBF Converter To transfer text file into DBF file.

Language To select a preferred language for the program GUI.

Help About Forge AG To show information about the Application Generator.

PREFERENCES

 Auto pre-load the last editing file.
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You may select the check box so that the last editing file will be loaded upon running
the AG program (ForgeAG.exe).

 Always on top.

You may select the check box so that the AG program (ForgeAG.exe) always remains
on top of all other windows on the desktop.

AGX TEMPLATE CONVERSION

Click to convert the AGX Template to different terminal type. The following items will be
changed during the converting process:

1. Upload /Download interface will be changed.

Original Device Target Device Upload Interface Download Interface

8300 8000 Original Target Original Target

Direct-RS232 Cradle IR Direct-RS232 Cradle IR

Keyboard
Wedge

8400 Cradle IR RS232 Cradle IR RS232

Keyboard
Wedge

USB HID

8500 8400 Cradle IR RS232 Cradle IR RS232

IrDA IrDA

Bluetooth SPP
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2. Prompts & Messages will be changed:

(1) Default prompts & messages on startup page

(a) The Interface prompts of upload port and download port wi ll be reset to the
default interface prompts of the target device’s upload port and download
port.

(b) For 8500 series, if you click “Convert to 8400”, the “F8:Edit  F9:Del” frame
on the interface will be changed to 8400 default prompts “F8:Edit  Del:Del”.
(See the following graphic.)

(c) If you convert the 8300 AGX template to the 8000 AGX template, the
prompts which are too long will be cut down.

(2) Prompts on Form/Menu pages

You may convert the prompts to another AGX template by template conversion.
But if you convert the 8300 AGX template to the 8000 AGX template, the
prompts on Form/Menu pages will be cut down.
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RECENT FILE LIST

If you ever saved a template, it will be displayed in the Command Menu as well. Up to 4
recent template files are listed for quick access.

 You may click any of the four files to open the template for editing. It will then be
placed on top of the list.

LANGUAGE

If there is any language file (*.lng) saved in the language folder where the AG
program is saved, language options will become available. You will be able to select a
preferred language for the GUI of the program. Refer to Localization.

Recent File List
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TOOLBAR MENU

The toolbar menu offers most of the functions listed in the command bar. Click the Icon
on the toolbar for a quick launch.

Icons Command Description

New  To create a new application template.

Open  To open an existing application template. File path needs to be
specified.

Save  To save the current editing template.

Send
Application

 To download the current application template to the mobile
computer.

Send Lookup  To download associated lookup file(s) to the mobile computer.

Get File via
Direct-Link

 To receive data from the mobile computer.

About Forge
AG

 To show information about the Application Generator.

Exit  To close the Application Generator.

APPLICATION TEMPLATE

To work on a new or existing application template, click the New or Open command.

An application template is composed of six tabs; each is a property page for custom
configurations.
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Property Pages

Startup You may configure program sequences and customize user interface on the mobile
computer.

Settings You may configure system settings so that they will take effect when initialization is
done on the mobile computer.

Symbology You may configure symbologies and barcode parameters.

Menu Menus are used to provide multi-level options, which may be placed under the main
menu, e.g. [1. Collect Data] > Menu 1 > (Menu 2) > Form 1.

Lookup Data of forms may make reference to one or up to 3 lookup files. You need to specify
the data format of a lookup file.

Form Forms are used to show information and allow for data input, which may be placed
under a user menu, e.g. [1. Collect Data] > (Menu 1) > Form 1.

Warning: On the Symbology tab, you must select the correct barcode reader in the
initial setting page even though no modification is made to its settings.
Otherwise, it will indicate "wrong reader type" after downloading the
template file to the mobile computer and cause the reader to fail!

PROGRAM SIMULATION

When you have completed the entire configuration, download the application template
file (.AGX) to the mobile computer.

COLLECT DATA
Main Menu
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UPLOAD DATA

No simulation.

 Refer to section 1.2.3 Record and 3.3.2 Lookup Data Can Be Uploaded. Normally, it
will proceed to connect via the selected upload port.

 Refer to section 5.1.1 Data Deletion for data manipulation.

UTILITIES

 In the application template file, the upload and download settings for the mobile
computer and PC side must match. Refer to the Command Bar: [Tools > Send
Application] for the property page.

User Menu

Form 1



14

FORGE Batch Application Generator User Guide

 If a lookup file is specified in use on the Lookup property page, [3. Utilities] > [8.
Calculator] will be replaced by [3. Utilities] > [8. Load Lookup File] after you
download the template file to the mobile computer.

LOCALIZATION

If you want to customize the entire application to your local language, you must translate
the text of the user interface into your own language, as well as re -define menus and
messages for the runtime.

1) Download the desired font file (.SHX) to the mobile computer v ia the "Program Load"
utility.

On the mobile computer, press [7] + [9] + [Power] simultaneously to enter System
Menu > Load Program.

2) Save the original language file (.lng) of the AG program as a new file - translate the
text of the user interface from English to another language.

3) Click [Language] from the Command Menu and select this new .lng file for the current
language.

4) Re-define the template prompts and messages on the Startup property page of the
application template.

 Apply large font on the Form and Menu property pages for double-byte languages
such as Japanese, Chinese, etc., so that their contents will be displayed properly
on the actual screen. However, the rest of prompts and messages can only be
displayed in alphanumeric characters in the current system.

5) Click [Send Application] to download the template file (.AGX) to the mobile computer.

6) Turn on the mobile computer to run the AG runtime program, U8*.SHX.

Select [3. Utilities] > [6. Load Application] to download the template file.
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A form is a data collection template with input prompts. Data will be kept as a
transaction record after the user completes all the input fields (lines) of a form. Then, it
can be saved in a transaction file, added to its lookup database, or directly output to a
printer, etc.

 Each form allows at most eight input fields (8 lines).

 Ten different forms can be defined.

The attributes on this property page are explained in detail as follows.

Chapter 1
FORM

1

2

3

4

5

6

9 10 11 12

7

8 13 14
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1.1 TO DENOMINATE A FORM

Select a name for the form you work on. Usually start with "form 1".

 form 1 ~ 10

1.2 PROPERTIES

1.2.1 ESC

Select a form or menu that will be displayed when you press the [ESC] key on the mobile
computer. For settings of user menus, refer to the Menu property page.

 Main Menu

 form 1 ~ 10

 menu 1 ~ 10

Note: Normally, the [ESC] key is used to return to a previous form or menu.

1.2.2 NEXT

Select a form or menu that will be displayed when the last input field of the current form
has been completed. For settings of user menus, refer to the Menu property page.

 Main Menu

 form 1 ~ 10

 menu 1 ~ 10

This function is invoked by sending the key value of [Enter] when you finish with the last
input field. And, the setting of section 1.10 Input Type decides the way to produce the
key value of [Enter].
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Input Source of the last line Operation

Reader In section 1.14 More, Auto ENTER for barcode input must be
configured as "Scan + ENTER".

Keypad Press the [Enter] key on the 8000/8300/8400/8500 Series
mobile computer.

Both See the two options above.

RFID Press the [Enter] key on the 8300/8500 Series mobile
computer.

All See all the options above.

1.2.3 RECORD

Select which action to take as soon as the input fields of a form have been completed.

Options Action...

Save To save the record to a sequential data file.

Update lookup To update the lookup file associated with the form.

Save & update To save the record to a sequential data file, and update the lookup file.

Pass down To pass down data to the next form or menu without saving.

Output record To output the record directly to a printer through COM port instead of saving
it to a file.

Output screen Similar to "output record". To output what is displayed on the screen, such
as the prompts and data collected.

Save & output
record

To save the record to a sequential data file and output it directly to a printer
through COM port.

Save & output
screen

To save the record to a sequential data file and output what is displayed on
the screen to a printer through COM port.

Remove from
lookup

To remove the record from the lookup file.

Save & remove To save the record to a sequential data file and remove it from the lookup
file.

Note: Instead of saving all the collected data to a data file, you may select to save the
collected data for each form to separate data files on the Menu property page.

Based on the selected option of Record and section 3.3.2 Lookup Data Can Be Uploaded,
you can upload data file(s) or lookup file(s), or both files ("All, one by one"), or even
merge them to a new file ("All, append").

Note: The uploaded file is a sequential file.

 Data file:
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This is available only when you have selected "save", "Save & update", "Save &
output record", "Save & output screen", or “Save & remove” for Record.

 Lookup file:

This is available only when you have specified a lookup file in use and allowed it to be
uploaded.

On the mobile computer, select [2. Upload Data] after you have completed the data
collection task and establish a proper connection with the server.

Warning: If you have selected "output record" or "output screen" for Record, [2.
Upload Data] on the mobile computer will become unavailable.

1.3 FONT SIZE

Large font (8x16) must be applied for double-byte languages, such as Chinese, Japanese,
etc. On the Form and Menu property pages, font size needs to be changed accordingly.
Refer to Localization.

Mobile Computer Small (Font 6x8) Large (Font 8x16)

8000 Series 16 characters by 8 lines (default) 12 characters by 8 lines

8300 Series 20 characters by 8 lines (default) 15 characters by 8 lines

8400 Series N/A 20 characters by 9 lines

8500 Series N/A 20 characters by 9 lines

Note: This setting is not available for 8400/8500 Series because it must use large font.

1.4 LOOKUP (FILE)

A lookup file is a database. Select whether or not a lookup file is associated with the
form.

If a lookup file is used, its data format must be defined on the Lookup property page,
especially the member length and number of fields.

On this property page, some related settings must be configured.

 section 1.8 Data Type

 section 1.4 Lookup (File)

Note: The associated lookup file(s) must be downloaded to the mobile computer.
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1.5 DATE & TIME STAMP

This feature actually includes Date and Time stamp. It may be helpful in analyzing data
when the date and time information is joined in each record.

 Stamp Position

You can select whether or not to enable the stamp function and include the date/time
information, either to the beginning or to the end of a record.

 Date & Time Format

Select the format of the Date and Time stamps. To stop the use of either stamp, clear
all the associated settings.
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1.6 BRANCH

Normally, a form is to be followed by either another form or menu. This feature is
provided when a form is designed to lead to more than one other form. Also, it allows the
linking to another form, which may jump over a number of forms or menus. Up to four
branches are provided through the use of function keys.

Take the following illustration for example.

Note: Data cannot be passed down through branches.

1.7 RESET CURRENT FORM

Press this button to reset current form to default.
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1.8 DATA TYPE

Specify the data type line by line to address your application requirements.

The associated settings for each data type are marked in the table below.

Data Type Prompt Input
Source

Length Lookup Properties

on-screen saved in record Min / Max Field More...

nil

text      

letter      

alphanumeric      

integer      

real      

auto (+/-)      

extension      

pass down      

boolean      

lookup  User-definable    

fixed data      

prompt      

pause      

counter      

1.8.1 NIL

No data input is allowed.

 This is the default setting. There will be single line spacing on the mobile computer
screen.
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1.8.2 TEXT

ASCII character – any character is acceptable. For example, $1a2b3c=-*/…

1.8.3 LETTER

Alphabetic character – any letter is acceptable, capital or small (Aa ~ Zz).

1.8.4 ALPHAMERIC

A combination choice of alphabetic (1.9.3) and numeric (1.9.5); any alphabet or
number is acceptable. For example, ABC123xyz

1.8.5 INTEGER

Whole number - any number is acceptable, such as … -2, -1, 0, 1, 2 …

1.8.6 REAL

Read number – any number with a decimal representation is acceptable, rational or
irrational. For example, 4.56

 When integer or real is selected along with lookup field specified, the lookup value
will be first displayed in the input field on the mobile computer screen. Then, data
input is allowed.

Lookup (field) If you select "Save & Update" for Record...

Field 1 ~ 8 The input value will overwrite the lookup value. No arithmetic operations
are performed.

+Field 1 ~ 8 It will automatically add the input value to the lookup value.

- Field 1 ~ 8 It will automatically subtract the input value to the lookup value.
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1.8.7 AUTO (+/-)

This is similar to data type integer, except that the lookup value is displayed before the
input field. There may be an arithmetic sign (+, -) in front of the input field, which
depends on the setting of the lookup field.
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1.8.8 EXTENSION

No data input is allowed.

 The line needs to be reserved as an "extension" of the previous line so that the whole
input data can be displayed on the mobile computer screen.

Note: The number of extension lines depends on the maximum length of your data and
the screen size of the mobile computer.

Take the following for example –

If the screen of the mobile computer allows 20 characters per line for small font,

 Now the prompt string ("Description:" in line 2) takes 13 characters, and the data
length is 15 characters at most.

 This makes the total length 28 characters at most, which is longer than one line.

 As a result, the data type of line 3 needs to be set "extension" if you want to display
the input data in full.

1.8.9 PASS DOWN

No data input is allowed.

 Data of this line may be imported from a previous form, of which the setting of
Record is specified as "pass down". When one line is not enough for displaying the
inherited contents, set its following line(s) to be an "extension". Or, it may be
imported from a menu, of which the setting of Data is specified as "pass down".

Note: This data type is used to combine a number of forms so that they can be saved as
one record.
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1.8.10 BOOLEAN

Only one of these sets of values are acceptable - "0 or 1", "Y or N" and "T or F".

 If you input a value other than the above ones, a message will be displayed on the
mobile computer to indicate "Data type is wrong!"

1.8.11 LOOKUP

No data input is allowed.

 When data of a previous input field is found matching with the "key field" of a lookup
file, data of this input field will be imported from its associated lookup field. By
default, the imported data will not be saved in the transaction record. In section 1.14
More as shown below, you may select Save field data.

Note: The lookup value is imported for reference. No change is allowed.

1.8.12 FIXED DATA

No data input is allowed.

 The prompt string will be saved as part of the transaction record.

1.8.13 PROMPT

No data input is allowed.

 The prompt string will not be saved.
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1.8.14 PAUSE

No data input is allowed.

 The prompt string will not be saved. However, it will be highlighted constantly on the
mobile computer to catch your attention.

1.8.15 COUNTER

No data input is allowed.

 The current record count will be displayed in five digits, starting from 00000. Refer to
section 5.1.1 Entry Options.

Note: When the main menu appears, the record count will be displayed on the bottom of
the screen (next to date and time).

1.9 PROMPT

Specify a prompt string for a specific input field, if necessary.

Note: Unless data type of a line is "fixed data", a prompt string will not be saved in a
transaction record.

1.10 INPUT TYPE

Specify from which source data can be collected.

 Reader

 Keypad

 Both

 RFID (only applicable to 8300, 8500 Series)

 All (only applicable to 8300, 8500 Series)

Upon completion of one input field, it is necessary to press the [Enter] key on the mobile
computer. Then, it will move either to the next input field, or to the next form or menu.

When the input source is specified to "reader" only, you need to enable "Auto ENTER" for
barcode input settings in section 1.14 More.

Note: When "RFID" is selected, you may still press the [ESC] or [Enter] key to cancel or
confirm a task. The rest keys on the keypad are disabled.
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1.11 MINIMUM LENGTH

Specify the minimum length of an input field.

 If the input data is shorter than specified, it will be considered unacceptable. A
warning message will be displayed to indicate "Data is too short!"

1.12 MAXIMUM LENGTH

Specify the maximum length of an input field. The value can be 80 at most in 8000/8300
and 160 at most in 8400/8500.

You can facilitate data input by showing input marks on the screen. In section 1.14 More,
select Show input mark. The number of input marks equals to the maximum length
specified here.

 If the input data is longer than specified, it will be considered unacceptable.

1.12.1 INPUT VIA BARCODE/RFID READER

For data input from the barcode or RFID reader, a warning message will be displayed
when data is too long.

1.12.2 INPUT VIA KEYPAD

For data input from the keypad, it will be allowed even though data has become longer
than the screen can display.

Take the scenario below for example.

 The screen of the mobile computer allows 20 characters per line for small font.

 Each prompt string takes 12 characters.
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Line Input from Keypad Screen Reading Transaction Record

#1 12345678 12345678 12345678

1234567890 34567890 1234567890

1234567890ABCDE 3456789E 123456789E

#3, 4 1234567890A 123456789A 123456789A

#5, 6 1234567890LEMONADE 1234567890LEMOE 1234567890LEMOE

#7, 8 1234567890ORANGE_JUICE 1234567890ORANGE_JUICE 1234567890ORANGE_JUICE

1.13 VARIABLES

If there is no lookup file in use, this feature will be Variables. Refer to section 1.4
Lookup (File).

1.13.1 LOOKUP (FIELD)

If a lookup file is in use, you need to specify the corresponding lookup field line by line.
For each lookup file, there will be a key field. Normally, the "key field" is Field #1. When
an input field makes reference to the key field and its input data is found matching, data
for its following input fields will be imported from each corresponding lookup fields.

 For those data types other than integer, real, and auto (+/-), see left below.

 For data types integer, real, and auto (+/-), see right below.

When an arithmetic sign (+, -) is prefixed to the lookup field, the input data will be
added or subtracted from the lookup value.

Lookup Field for data type:
integer,
real,
auto (+/-)

Lookup Field for data type
other than
integer,
real,
auto (+/-)
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1.13.2 VARIABLES

If there is no lookup file in use, it will provide variables, which can be accessed by
different forms.

For example,

 Select set v1 for input field #1 of form 1, and its input data will be saved in the first
character array.

 Select get v1 for input field #3 of form 2, and the previous input data will be
imported.

 Select get&set v1 for input field #3 of form 2, the previous input data will be
imported and then updated.

1.14 MORE

Specify field properties if necessary.

1.14.1 FIELD DATA

FIXED DATA LENGTH

Select the check box. The data length will be fixed to the value specified here.

 If the input data is longer, it will be truncated.
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 If the input data is shorter, "Space" or "0" will be added in front of or to the end of
the data based on either "Left" or "Right" alignment.

Below are some examples.

Fixed data length Alignment Input data Transaction record

4 Left aligned / space 123456789 1234,

4 Right aligned / space 123456789 6789,

10 Left aligned / 0 7654321 7654321000

10 Right aligned / 0 7654321 0007654321

INITIAL VALUE OR TEXT

Select the check box. An initial value or text, up to 9 characters, specified here will be
shown in the input field. It is to be replaced by input data.

For example, it can be used to prompt an initial value for quantity.

ADD PREFIX CODE

Select the check box to prefix a code to the input data. Click the editing box next to it,
and select one or more codes from the Grid Control (ASCII codes). For example, a dollar
sign ("$") can be added to the front of the data input for price.

ADD SUFFIX CODE

Select the check box to suffix a code to the input data. Click the editing box next to it,
and select one or more codes from the Grid Control (ASCII codes).

Instead of using delimiters in section 6.3 Data Field Properties, you may use prefix
and/or suffix codes to separate each entry of input data.

Note: You may use prefix/suffix code to wrap the input data.

SHOW INPUT MARK

Select the check box to show input marks, such as underline (_) or asterisk (*), which is
to be replaced by input data.

The number of input marks shown on the screen equals to the maximum length of data
specified in section 1.12 Maximum Length.
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DECIMAL PLACES

A decimal place is the position of a digit to the right of a decimal point. When the data
type is real, you may need to specify its decimal places.

 By default, it is set variable to accept all real numbers.

For example, 4 is selected for decimal places, however, there are only 2 decimal places
in the input number, say "8.12". To follow this rule, the system will save the input data
as "8.1200". If the input number is "8.12345", it will be saved as "8.1234".

1.14.2 BARCODE INPUT

READ PARTIAL BARCODE

By default, it will return the whole barcode that has been decoded. When the check box
is selected, it will return partial barcode according to the settings of the start position and
maximum length.

Below are some examples.

Start position Max. length Barcode scanned Transaction record

2 10 9876543210 876543210

2 3 9876543210 876

CHECK LEADING CODE

The leading code refers to the digit in the start position of a barcode.

Select the check box to verify the barcode input. When the leading code is not matching,
the barcode will be rejected.

Below are some examples.

Leading code Barcode scanned Transaction record

9 9876543210 9876543210

2 9876543210 (Error: code not matching)

Read partial code + Check leading code:

Start position Max. length Leading Code Barcode scanned Transaction record

2 7 8 9876543210 8765432

2 7 9 987654321 (Error)
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CHECK DIGIT VERIFICATION

The check digit refers to the digit in the end of a barcode, as a one -digit derived
checksum digit. Select the check box to verify the barcode input. You may apply different
modulus 10 or 11 check digit as provided in the drop-down menu. When the check digit
is not matching, the barcode will be rejected.

AUTO ENTER

Normally, it is necessary to press the [Enter] key on the mobile computer upon
completion of one input field. Then, it will move either to the next input field, or to the
next form/menu specified. This function will automatically add a carriage return in front
of or to the end of the barcode input.

 For barcode scanning, it proves to be timesaving when Scan+ENTER is enabled.

 For a typical application of continuous scanning, it is effic ient by making use of
ENTER+Scan.
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A menu is a list of selection items. Up to ten different menus can be defined.

Below are the settings for each field of a menu.

IN THIS CHAPTER

2.1 To denominate the menu ............................................. 33
2.2 Properties...................................................................34
2.3 Font Size....................................................................34
2.4 Data .......................................................................... 34
2.5 Save forms specified in all menus to separate files .......... 35
2.6 Item Name .................................................................35
2.7 Next .......................................................................... 35
2.8 Reset Current Menu..................................................... 36

2.1 TO DENOMINATE THE MENU

Select a name for the current menu you work on. Usually start with "menu 1".

 menu 1 ~ 10

Chapter 2
MENU
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8
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2.2 PROPERTIES

2.2.1 MENU CAPTION

Select the check box and specify a caption for the current menu if necessary.

2.2.2 ESC

Select a form or menu that will be displayed when you press the [ESC] key on the mobile
computer.

 Main Menu

 form 1 ~ 10

 menu 1 ~ 10

Note: Normally, the [ESC] key is used to return to a previous form or menu.

2.3 FONT SIZE

Large font (8x16) must be applied for double-byte languages, such as Chinese, Japanese,
etc. On the Form and Menu property pages, font size needs to be changed accordingly.

Refer to Localization and section 1.3 Font Size.

2.4 DATA

Specify how to proceed when a menu item has been selected.

2.4.1 SAVE CAPTION

Save the menu caption to the transaction record if this menu is running.

2.4.2 SAVE SELECTED ITEM

Save the selected menu item to the transaction record if this menu applies.

2.4.3 PASS DOWN

If you have selected to save any of the above items, decide whether or not to pass it to
the next menu or form. (No menu caption or item saved to the transaction record.)

 Save caption & pass down

 Save selected item & pass down

 Save both & pass down
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Note: The selected option(s) will be passed down to an associated form or menu.

2.5 SAVE FORMS SPECIFIED IN ALL MENUS TO SEPARATE FILES

When a menu leads to more than one form, you may select the check box t o save the
data collected from each form to individual files.

The check box of "Pass down" for Data will automatically be selected.
That is, the menu caption or selected item name will be saved together
with separate forms if you have selected the check box for each.

2.6 ITEM NAME

Specify a name for each menu item. It allows up to ten menu items.

For example, you may specify "1. Goods In" or "Goods In" (see below) in the first field of
Item Name.

Note: Whether you have included Item No. in the name field, you can press [1] on the
mobile computer to enter the "Goods In" menu.

2.7 NEXT

Select a form or menu that will be displayed when a menu item has been selected.

 Main Menu

 form 1 ~ 10

 menu 1 ~ 10

This function can be invoked by performing one of the following actions on the mobile
computer -

 Press the shortcut key (Item No.) of a menu item, e.g. press [2] to select the second
menu item. The form or menu you specified here will be displayed then.

 Press the [Up/Down] arrow keys to select a menu item, and then press [Enter].

Caption

Item Name
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2.8 RESET CURRENT MENU

Click this button to load the default settings.

Note: The current settings for all menus will be cleared.
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A lookup file is a database file created for information reference. Up to three lookup files
can be defined.

If settings on this property page are specified improperly, it may go wrong when an input
field makes reference to its corresponding lookup field.

If the default settings remain unchanged for the following items in the AG template file
that has been downloaded to your mobile computer, [3. Utilities] > [8. Load Lookup File]
will be unavailable.

 section 1.4 Lookup (File)

 section 3 Lookup

Other related settings:

 section 1.8.11 Lookup (Data Type)

 section 1.13.1 Lookup (Field)

Chapter 3
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IN THIS CHAPTER

3.1 To denominate a lookup file .......................................... 38
3.2 Field Property ............................................................. 38
3.3 Lookup Data ............................................................... 39
3.4 Action When the Input Data Has No Match ..................... 39
3.5 Offset ........................................................................ 40
3.6 (Max) Length .............................................................. 41
3.7 Key Field ....................................................................41
3.8 Action When the Format of Record Is Wrong ................... 41
3.9 Reset Current Lookup File............................................. 42

3.1 TO DENOMINATE A LOOKUP FILE

Select a lookup file you want to define its settings. Up to 3 different lookup files can be
specified. Usually start with the "1st lookup file".

3.2 FIELD PROPERTY

Specify the settings of data field of the database (lookup file).

3.2.1 NUMBER OF FIELDS

It must at least cover the referred fields of the database (lookup file).

Refer to section 1.13.1 Lookup (Field).

3.2.2 FIXED LENGTH

This is the default setting. Proceed to define related settings -

 Number of fields

 Offset

 Length

3.2.3 DELIMITER

You may use a delimiter (ASCII code) to separate the data fields. Proceed to define
related settings -

 Number of fields

 Max. Length

If the maximum length of each field is set improperly, you will receive a warning
message during downloading. You may fail to download the lookup file, depending on the
action specified when the data format is wrong.



39

Chapter 3 Lookup

Refer to the settings of section 3.8 Action When the Format of Record Is Wrong.

3.2.4 DBF FILE LOCATION

You may specify the location to store the DBF files. The options are as follows:

 SRAM

 SD Card

3.3 LOOKUP DATA

3.3.1 ONLY READ DATA ONCE

Select the check box to compare data of an input field and the key field of the lookup file
it refers to.

If this function is enabled, Insert to lookup file will be automatically set in section 3.4
Action When the Input Data Has No Match, and you may change it to Show Warning
Message & Insert.

 When the data is found matching (i.e. data already exist), th is record will be rejected.

 When the data is found no matching (i.e. new data), it will be inserted to the lookup
file.

3.3.2 LOOKUP DATA CAN BE UPLOADED

This is the default setting. The lookup data can be uploaded from the mobile computer to
your computer. On the mobile computer, select [2. Upload Data] after you have
completed the data collection task and establish a proper connection with the server.

Refer to section 1.2.3 Record.

3.4 ACTION WHEN THE INPUT DATA HAS NO MATCH

Choose the appropriate action to take when the input data does not match that of the
“key field”.

3.4.1 CONTINUE

The program will allow data input to proceed without showing any message.

 Data can only be saved in a data file if you have selected "Save", "Save & update",
"Save & output record", "Save & output screen" or “Save & remove” in section 1.2.3
Record.
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3.4.2 SHOW WARNING MESSAGE

The program will suspend and a warning message "Data not found!" is displayed on the
mobile computer.

 You will need to clear the input data manually (that is, 9990, in the example below).

3.4.3 INSERT TO LOOKUP FILE

The program will allow data input to proceed without showing any message.

 Data will be inserted to the target lookup file if you have selected "Update lookup" ,
"Save & update", “Remove from lookup”, or “Save & remove” in section 1.2.3 Record.

3.4.4 SHOW WARNING MESSAGE & INSERT

The program will suspend and a warning message "Data not found!" is displayed on the
mobile computer. Then, it will resume to data input. Data will be inserted to the target
lookup file if you have selected "Update lookup", "Save & update", “Remove from lookup”,
or “Save & remove” in section 1.2.3 Record.

3.4.5 CLEAR THE SCREEN

The program will automatically clear the input data and wait for new entry.

3.4.6 SHOW WARNING & CLEAR SCREEN

The program will suspend and a warning message "Data not found!" is displayed on the
mobile computer. Then, it will automatically clear the input data and wait for new entry.

3.5 OFFSET

This applies to Fixed Length. Specify the start position for each referred data field.
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3.6 (MAX) LENGTH

 When the field property is set Fixed Length, specify the length for each referred
data field. The value can be 255 at most.

 When the field property is set Delimiter, specify the maximum length for each
referred data field. The value can be 255 at most.

Note: If a delimiter is used to separate data fields, any improper value would cause
wrong data format.

3.7 KEY FIELD

The import of data depends on the key field. Select your key field so that an index file
can be created for the database (lookup file).

 When a form makes reference to a lookup file, there must be one input field
associated with the key field of the database (lookup file).

When its input data is found matching with that of the key field, data of other input
fields, if referring to a lookup field, will be imported accordingly.

If no matching, see section 3.4 Action When the Input Data Has No Match.

Note: If offset and length of each field are specified improperly, it may go wrong with
data import.

3.8 ACTION WHEN THE FORMAT OF RECORD IS WRONG

This applies to Delimiter, when a delimiter is used to separate data fields of the lookup
file. It provides several options to handle wrong data format when you download the
lookup file to the mobile computer.

3.8.1 STOP THE DOWNLOAD PROCESS

When wrong data format is encountered, a warning message will be displayed on the
mobile computer to indicate which line is found format mismatching. The downloading
process is stopped then. You will need to correct the data format, for example, remove
an empty record (line) at the end of a file. Then, download the lookup file again.
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3.8.2 TRUNCATE / REFORMAT THE RECORD

When wrong data format is encountered, a warning message will be displayed on the
mobile computer to indicate the mismatching part has been fixed, being automatically
truncated or reformatted during downloading.

For example, the additional fields of a record will be left out. However, you may need to
reload the lookup file after the data format has been corrected.

3.8.3 SKIP THE RECORD

When wrong data format is encountered, a warning message will be displayed on the
mobile computer to indicate the mismatching part has been discarded. You may need to
reload the lookup file after the data format has been corrected.

3.9 RESET CURRENT LOOKUP FILE

Click this button to load the default settings.

Note: The current settings for all lookup files will be cleared.



43

According to the requirements of a specific application, you may enable or disable any of
the barcode symbologies and configure the associated parameters.

Supported barcodes depend on the scan engine integrated on the mobile computer.

IN THIS CHAPTER

4.1 Reader Settings .......................................................... 43
4.2 Code ID .....................................................................44
4.3 Reset ......................................................................... 44
4.4 Barcode & Parameters ................................................. 44

4.1 READER SETTINGS

Refer to the following appendices for information on barcode reader settings —

 Appendix II - CCD/Laser Scan Engine for details.

 Appendix III - LR/ELR Laser Scan Engine for details.

 Appendix IV - 2D Scan Engine for details.

4.2 CODE ID

Chapter 4
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If this function is enabled, specify Code ID for a listed barcode. The Code ID will be
prefixed to the decoding result of a barcode.

 Click the editing box next to the barcode, and select one code from the Grid Control
(ASCII codes).

Alternatively, you may select Set 1 ~ 5. (Discrete 25 = Industrial 25)

Note: Code ID settings for GS1 Databar-14/Expended, GS1 Databar Limited, and
GS1-128 are provided in section 4.4 Barcode & Parameters.

4.3 RESET

Click [Reset] to load the default settings. This applies to the following -

 section 4.1 Reader Settings

 section 4.4 Barcode & Parameters

Note: The current settings will be cleared.

4.4 BARCODE & PARAMETERS

Refer to the following appendices for information on symbology settings —

 Appendix II - CCD/Laser Scan Engine for details.

 Appendix III - LR/ELR Laser Scan Engine for details.

 Appendix IV - 2D Scan Engine for details.
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On this property page, basic settings for the application program can be changed.

 Wedge Settings is available in AG8300 only.

IN THIS CHAPTER

5.1 Initial Setting.............................................................. 45
5.2 Function Key Setting.................................................... 53
5.3 Security Setting .......................................................... 54

5.1 INITIAL SETTING

5.1.1 DATA MANIPULATION

DATA DELETION

By default, you need to select [3. Utilities] > [3. Delete Data] and manually delete a file.
You may select to automatically delete data file(s) or lookup file(s) once it has been
uploaded to the server. If so, the file will not be available any more when you select the
following submenus -

 [2. Upload Data]

 [3. Utilities] > [2. Browse Data]
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If you don’t want to delete any data file(s) or lookup file(s), please select “Always keep”.
The data file(s) and lookup file(s) will always be kept in the mobile computer.

ENTRY OPTIONS

You may specify whether or not to display more information, either the record c ount
(Show count) or the record preview (Show record), before proceeding to the next entry.
By default, the record count will be displayed on the mobile computer screen for 600
milliseconds as soon as an entry is completed. Refer to 1.8.15 Counter.

When selecting "Show count" or "Show record", you will need to specify how long it will
be displayed on the screen. Time-out is specified in the range of 1~99, in units of 100
milliseconds.

5.1.2 KEYPAD & LCD

KEY CLICK

By default, "Tone 2" is used for the key click. You may select a desired tone or mute it.

BACKLIGHT

By default, the backlight for the LCD and the keypad of the mobile computer is turned
off.

When the backlight is turned on, you may specify a period of idle t ime so that it can be
automatically turned off. Such time-out is specified in the range of 1~9, in units of 10
seconds. The default time-out is 20 seconds.

5.1.3 NOTIFICATION

WARNING BEEP

You may specify whether or not to have a warning beep when a specifi c event takes
place. By default, it will produce two beeps to warn you of a specific event.

GOOD READ BEEP

You may specify whether or not to have a beep when decoding of a barcode is done
successfully. By default, it will produce one beep to inform you of a successful reading.

VIBRATOR DURATION

This is available in 8300/8400/8500 program only. You may specify whether or not to
turn on the vibrator to warn you of a specific event. By default, the vibrator is turned off.

You may turn it on for a preset period of time.
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5.1.4 READER OPTION

READER TYPE

Refer to Appendix I - Scan Engine Settings for information on barcode reader and RFID
reader.

BARCODE READER

Select a reader type that matches the hardware configuration of your mobile computer.
The associated barcode parameters will be displayed accordingly. If there is a More
button next to the barcode symbology listed, advanced settings are available.

Note: In order to initialize the barcode reader, you must select the correct reader type
when you first configure a template. Otherwise, a message will be displayed on
the mobile computer to indicate "Wrong reader type!" after you download the
template file.

RFID READER

The RFID reader is automatically enabled after initialization. Advanced settings are
provided as shown below. RFID tags in proximity will be read automatically by
8300/8500 when RFID reader is enabled. You may limit the 1.10 Input Type options in
Form to prevent from misreading RFID data.

Read UID

By default, the RFID reader is set to read UID (Unique Identification).

Read Data

 Select the check box so that RFID data can be read.

 If only partial data is required, specify the start position and maximum length.

User Delimiter

Select the check box and specify a delimiter to separate UID from data.
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5.1.5 UPLOAD & DOWNLOAD SETTINGS

Settings Default Value Remarks

1. Upload Port Cradle-IR (For 8400,
the default setting is
RS232.)

Bluetooth SPP is not available on the
mobile computer unless selected for
downloading to 8061, 8360.

2. Download Port Cradle-IR (For 8400,
the default setting is
RS232.)

3. Modem Speed (115200 bps)

4. Baud Rate 115200 bps

5. Backlight Turn off

6. Data Deletion Manual

7. Entry Options Show count Stay on the LCD for 600 ms

8. Key Click Tone 2

9.Barcode Good Read One beep

10. Warning Beep Two beeps

11. Vibrator Duration Off

12. Buzzer Volume SMALL_VOL Only for 8400

UPLOAD METHOD

Select a communication interface used on the mobile computer to upload data file(s) or
lookup file(s) to your computer.

AG - Upload Port Remarks

AG8000 Normally, the interface options on the mobile computer are

 Cradle-IR

 IrDA

 Modem

 Ethernet Cradle

However, if you download Batch AG runtime to 8061, Bluetooth SPP
must be selected for initial settings, and it will replace Modem
above; otherwise, this option will become unavailable on the mobile
computer –

 [3. Utilities] > [1. Program Settings] > [1. Upload Interface]

 [3. Utilities] > [1. Program Settings] > [2. Download Interface]
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AG8300 Normally, the interface options on the mobile computer are

 Direct RS-232

 Cradle-IR

 IrDA

 Keyboard Wedge

 Ethernet Cradle

 Modem

However, if you download Batch AG runtime to 8360, Serial-SPP
(=Bluetooth SPP) must be selected for initial settings, and it will
replace Modem above; otherwise, this option will become
unavailable on the mobile computer –

 [3. Utilities] > [1. Program Settings] > [1. Upload Interface]

 [3. Utilities] > [1. Program Settings] > [2. Download Interface]

AG8400 Because the 8400 Series comes with Bluetooth integrated, the
interface options on the mobile computer are

 RS232

 Bluetooth SPP

 USB VOM

 Modem

 Ethernet Cradle

 USB HID

 SD Card

AG8500 Because the 8500 Series comes with Bluetooth integrated, the
interface options on the mobile computer are

 Cradle-IR

 IrDA

 Modem

 Ethernet Cradle

 Bluetooth SPP

WEDGE SETTINGS

This feature is provided with the 8300 Series mobile computers, and ther efore, the
settings are available in AG8300 program only.

SD CARD SETTINGS (FOR 8400)

If you set the upload method to “SD Card”, you can upload the DAT files and DBF files to
the SD Card. The files will be saved to the default directory “SD Card
drive:\AG\EXPORT”.

DOWNLOAD METHOD

Select a communication interface used on the mobile computer to download the
application template or lookup file(s) to your computer.
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AG - Download Port Remarks

AG8000 Normally, the interface options on the mobile computer are

 Cradle-IR

 IrDA

 Modem

However, if you download Batch AG runtime to 8061, Bluetooth SPP
must be selected for initial settings, and it will replace Modem
above; otherwise, this option will become unavailable on the mobile
computer –

 [3. Utilities] > [1. Program Settings] > [1. Upload Interface]

 [3. Utilities] > [1. Program Settings] > [2. Download Interface]

AG8300 Normally, the interface options on the mobile computer are

 Direct RS-232

 Cradle-IR

 IrDA

 Modem

However, if you download Batch AG runtime to 8360, Bluetooth SPP
must be selected for initial settings, and it will replace Modem
above; otherwise, this option will become unavailable on the mobile
computer –

 [3. Utilities] > [1. Program Settings] > [1. Upload Interface]

 [3. Utilities] > [1. Program Settings] > [2. Download Interface]

AG8400 Because the 8400 Series comes with Bluetooth integrated, the
interface options on the mobile computer are

 RS232

 Bluetooth SPP

 USB VOM

 Modem

 SD Card

AG8500 Because the 8500 Series comes with Bluetooth integrated, the
interface options on the mobile computer are

 Cradle-IR

 IrDA

 Modem

 Bluetooth SPP

SD CARD SETTINGS (FOR 8400)

If you set the download method to “SD Card”, you can download the Lookup files and
AGX files from the SD Card. The default import directory is “SD Card drive:\AG\IMPORT”.
Before you download the Lookup files, you have to use the DBF converter tool to convert
txt files to Lookup files and then copy the Lookup files to the SD Card. Also, before
copying the Lookup files to the SD card, you have to create a file directory:\AG\IMPORT
in your SD card first. Then store the Lookup files and AGX files in this file folder so that
the files can be downloaded properly.
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DBF CONVERTER

1. Click [Tools > DBF Converter] to launch the DBF Converter program.

2. Follow the steps shown below to use the DBF converter:

1) Select a lookup file(*.txt).

2) Select an AGX file (*.agx).

3) Select a preexisted DBF file or click the “Build target” button to create a new DBF file
(*.db0).

4) Click the “Distribute DBF files” button to copy the DBF file to the SD card.
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5) Click the “Add file” to choose the desired DBF files (multiple-selection allowed).

6) Click the “Browse” button to choose the preset SD card import directory “SD Card
drive:\AG\IMPORT”.

7) Click “OK” to save the DBF files to the SD card.

5.1.6 BAUD RATE & MODEM SPEED

BAUD RATE

By default, the baud rate setting is 115200 bps for communications via any interface
except for Modem.

MODEM SPEED

Only when Modem is selected for Upload Port (5.1.1) or Download Port (5.1.2), this
option will become available. By default, the baud rate setting is 115200 bps for
communication.
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DIP SWITCH

This baud rate setting depends on the IR control board of the modem cradle, which is set
to 57600 bps by default. If you select any value other than 57600 bps, you need to
adjust the DIP switch of the control board accordingly.

Note: For the 8000/8300 Series, the version of IR control board on the modem cradle
must be greater than SV3.01.

5.1.7 RESET SETTINGS

Click this button to load the default settings. This applies to the following -

 section 5.1 Initial Setting

 section 5.2 Function Key Setting

 section 5.3 Security Setting

Note: The current settings will be cleared.

5.2 FUNCTION KEY SETTING

You may enable the function keys and define the mapping. That is, specify which task
will be invoked when you press a key combination. By default, no function keys have
been defined.
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5.3 SECURITY SETTING

For security concerns, you may specify a password and select the check box of one or
more tasks that need security checking. By default, no password is required for any task.

If any task is selected and provided with a password, you will not be allowed to enter a
submenu on the mobile computer without the password.

 A password can be up to 10 alphanumeric characters.

Note: The password is case-sensitive.

Security Options Remarks

Settings 3. Utilities > 1. Program Settings
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Edit Data 3. Utilities > 2. Browse Data

Delete Data 3. Utilities > 3. Delete Data

Set Date/Time 3. Utilities > 5. Set Date / Time

Load Application 3. Utilities > 6. Load Application

Load Lookup File 3. Utilities > 8. Load Lookup File

Key Click 3. Utilities > 1. Program Settings > 7. Buzzer > 1. Key Click

Warning Beep 3. Utilities > 1. Program Settings > 7. Buzzer > 3. Warning Beep

Upload Port 3. Utilities > 1. Program Settings > 1. Upload Interface

Download Port 3. Utilities > 1. Program Settings > 2. Download Interface

Baud Rate 3. Utilities > 1. Program Settings > 3. Transmission Speed

Backlight 3. Utilities > 1. Program Settings > 4. Backlight

Data Deletion 3. Utilities > 1. Program Settings > 5. Set Data Delete

Entry Options 3. Utilities > 1. Program Settings > 6. Entry Options

Barcode Good Read 3. Utilities > 1. Program Settings > 7. Buzzer > 2. Barcode Read
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On this property page, startup settings for the application program can be customized.

 Use large font for all prompts is NOT available in AG8500 and AG8400.

IN THIS CHAPTER

6.1 Application Start From ................................................. 57
6.2 Prompt Font Size......................................................... 58
6.3 Data Field Properties.................................................... 58
6.4 Redefine Prompts and Messages ...................................59
6.5 Import Prompts and Messages ...................................... 59
6.6 Reset Prompts and Messages to default ......................... 59

6.1 APPLICATION START FROM

Decide where the application program starts as soon as [1. Collect data] is selected on
the mobile computer.

 form 1

 menu 1

Chapter 6
STARTUP
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6.2 PROMPT FONT SIZE

You may select to use large font for all prompts. These two options are available in
AG8000 and AG8300 programs only because small font (6x8) is applied by default.

Large font (8x16) must be applied for double-byte languages, such as Chinese, Japanese,
etc. In that case, select the check box first so that all the prompts and messages will use
large font. Proceed to section

6.4 Redefine Prompts and Messages. On the Form and Menu property pages, font size
needs to be changed accordingly. Refer to Localization.

Note: These settings are not available for 8400 and 8500 Series because it must use
large font.

6.3 DATA FIELD PROPERTIES

6.3.1 NUMBER OF DELIMITER

The input data will be saved as transaction records. Specify the delimiters used to
separate data fields, either in ASCII code or text. It allows using up to two different
delimiters. Type the ASCII code for a delimiter and its corresponding character will be
shown automatically, and vice versa.

6.3.2 BROWSE DATA FONT SIZE

You may select to use large font for data browsing. These two options are available in
AG8000 and AG8300 programs only because small font (6x8) is applied by default.

Large font (8x16) must be applied for double-byte languages, such as Chinese, Japanese,
etc. In that case, select the check box first so that all the prompts and messages will use
large font. Proceed to section

6.4 Redefine Prompts and Messages. On the Form and Menu property pages, font size
needs to be changed accordingly. Refer to Localization.

6.3.3 DAT FILE LOCATION

You may specify the location to store the DAT files. The options are as follows:

 SRAM

 SD Card

Note: These settings are not available for 8400 and 8500 Series because it must use
large font.
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6.4 REDEFINE PROMPTS AND MESSAGES

For non-English environment, all the prompts and messages need to be re-defined in
your local language. In addition, the appropriate font file has to be downloaded to the
mobile computer so that it can display the prompts and messages correctly. Refer to
Localization.

6.5 IMPORT PROMPTS AND MESSAGES

If the prompts and messages have already been re-defined with an existing template file,
simply import the template file.

6.6 RESET PROMPTS AND MESSAGES TO DEFAULT

Click this button to load the default prompts and messages settings.

Note: The current settings will be cleared.
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The FORGE Application Generator allows configuring the following reader types,
depending on the module equipped on your mobile computer:

8000 8300 8400 8500

Barcode Reader

1D CCD Scan Engine    

1D Laser Scan Engine    

1D Long Range Laser Scan Engine (LR)    

1D Extra Long Range Laser Scan Engine
(ELR)

   

2D Scan Engine    

RFID Reader

ACG_RFID Module v0.9    

ACG_RFID Module v1.0    

Options of different reader combination are allowed, such as 1D+RFID and 2D+RFID. For
each combination, both readers can be initialized and ready for scanning at the same
time (dual mode operation). For example, if you press the [Scan] button while running
the AG run-time program on the mobile computer, it will read a barcode in position or an
RFID tag in proximity depending on which one comes first.

Note: You cannot have 1D+2D scan engines installed on the mobile computer because
they are both barcode readers!

SYMBOLOGIES SUPPORTED

Varying by the scan engine installed, the supported symbologies or tag types are listed
below. For details on configuring associated settings, please refer to each Appendix
separately.

CCD, Laser LR, ELR 2D

Codabar   

Code 11   

Code 93   

Composite Code   

MSI   

Plessey   

Appendix I
SCAN ENGINE SETTINGS



62

FORGE Batch Application Generator User Guide

Postal Codes   

Telepen   

Code 128 Code 128   

GS1-128   

ISBT-128   

Code 2 of 5 Industrial 25 (i.e. Discrete 25)   

Interleaved 25   

Matrix 25   

Code 3 of 9 Code 39   

Trioptic Code 39   

Italian Pharmacode (i.e. Code
32)

  

French Pharmacode   

EAN/UPC EAN-8   

EAN-13   

Bookland EAN (i.e. ISBN)   

UPC-E0   

UPC-E1   

UPC-A   

GS1 Databar GS1 Databar -14   

GS1 Databar Limited   

GS1 Databar Expanded   

2D
Symbologies

PDF417   

MicroPDF417   

Data Matrix   

Maxicode   

QR Code   

RFID TAGS SUPPORTED

The RFID reader supports read/write operations depending on the tags. The supported
labels include ISO 15693, Icode®, ISO 14443A, and ISO 14443B. Currently, the
performance of some tags has been confirmed, and the results are listed below for your
reference. The results found with RFID module version 1.0 are different from those found
with version 0.9 or older versions.

Note: You should study the specifications of RFID tags before use. The "Write Page"
functionality may not be supported.
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ACG_RFID Module Version 1.0 UID Only Read Page Write Page*

ISO 14443A Mifare Standard 1K   

Mifare Standard 4K   

Mifare Ultralight   

Mifare DESFire  --- ---

Mifare S50   

SLE44R35  --- ---

SLE66R35   

ISO 14443B SRIX 4K   

SR176   

ISO 15693 ICODE SLI   

SRF55V02P  --- ---

SRF55V02S  --- ---

SRF55V10P  --- ---

TI Tag-it HF-I   

ICODE®
(Phillips)

ICODE   

ACG_RFID Module Version 0.9 UID Only Read Page Write Page*

ISO 14443A Mifare Standard 1K  --- ---

Mifare Standard 4K  --- ---

Mifare DESFire  --- ---

Mifare S50  --- ---

SLE44R35  --- ---

SLE66R35  --- ---

ISO 15693 ICODE SLI   

SRF55V02P   

SRF55V02S  --- ---

SRF55V10P   

TI Tag-it HF-I   

ST LRI64   

ST LRI512   

Tagit® Tagit   

ICODE®
(Phillips)

ICODE   
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The tables below list reader settings as well as symbology settings for the CCD or Laser
scan engine.

READER SETTINGS TABLE

CCD/Laser Description Default

Time-out 3 sec.

1~255 (second) for
programming

Set the maximum time for decoding to continue during a scan attempt. It
applies to the following scan modes only –

 Aiming mode

 Laser mode

 Auto Off mode

 Auto Power Off mode

Scan Mode Laser mode

Continuous Mode Non-stop scanning

 To decode the same barcode repeatedly, move away the scan beam
and target it at the barcode for each scanning.

Test Mode Non-stop scanning

 Capable of decoding the same barcode repeatedly

Repeat Mode Non-stop scanning

 Capable of re-transmitting barcode data if triggering within one second
after a successful decoding

Momentary Mode Hold down the scan trigger to start with scanning.

 The scanning won't stop until you release the trigger.

Alternate Mode Press the scan trigger to start with scanning.

 The scanning won't stop until you press the trigger again.

Aiming Mode Press the scan trigger to aim at a barcode. Within one second, press the
trigger again to decode the barcode.

 The scanning won't stop until (a) a barcode is decoded or (b) the
pre-set timeout expires.

Laser Mode Hold down the scan trigger to start with scanning.

 The scanning won't stop until (a) a barcode is read, (b) the preset
timeout expires, or (c) you release the trigger.

Auto Off Mode Press the scan trigger to start with scanning.

 The scanning won't stop until (a) a barcode is read or (b) the preset
timeout expires.

Appendix II
CCD/LASER SCAN ENGINE
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Auto Power Off Mode Press the scan trigger to start with scanning.

 The scanning won't stop until the preset timeout expires, and, the
preset timeout period re-counts after each successful decoding.

Read Redundancy None

None No redundancy means one successful decoding will make the reading valid
and induce the "READER Event".

One time, Two times,
or Three times

The higher the reading security is (that is, the more redundancy the user
selects), the slower the reading speed gets.

 If "Three Times" is selected, it will take a total of four consecutive
successful decodings of the same barcode to make the reading valid.

SYMBOLOGY SETTINGS TABLE

CCD/Laser Description Default

Codabar Enable

Transmit Start/Stop
Characters

Decide whether to include the start/stop characters in the
data being transmitted.

If "Transmit Start/Stop Characters" is desired, select one
set:

 abcd / abcd

 abcd / tn*e

 ABCD / ABCD

 ABCD / TN*E

No

Code 128 Enable

GS1-128 Enable

Transmit Code ID (for
GS1-128)

Decide whether to include Code ID (“]C1”) will be included
in the data being transmitted.

No

Field Separator Decide whether to replace the field separator. No

Industrial 25 (= Discrete 25) Enable

Start/Stop Selection This decides the readability of all 2 of 5 symbology
variants. For example, flight tickets actually use an
Industrial 2 of 5 barcode but with Interleaved 2 of 5
start/stop pattern. In order to read this barcode, the
start/stop pattern selection parameter of Industrial 2 of 5
should set to "Interleaved 25".

Industrial 25

Verify Checksum Decide whether to verify the checksum. If the checksum is
incorrect, the barcode will not be accepted.

No

Transmit Checksum Decide whether to include the checksum in the data being
transmitted.

Yes

Select Length  One or two fixed lengths

 Range

1~127

Interleaved 25 Enable
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Start/Stop Selection Refer to Industrial 25. Interleaved
25

Verify Checksum Decide whether to verify the checksum. If the checksum is
incorrect, the barcode will not be accepted.

No

Transmit Checksum Decide whether to include the checksum in the data being
transmitted.

Yes

Select Length  One or two fixed lengths

 Range

1~127

Matrix 25 Enable

Start/Stop Selection Refer to Industrial 25. Matrix 25

Verify Checksum Decide whether to verify the checksum. If the checksum is
incorrect, the barcode will not be accepted.

No

Transmit Checksum Decide whether to include the checksum in the data being
transmitted.

Yes

Select Length  One or two fixed lengths

 Range

1~127

French Pharmacode Disable

*Transmit Start/Stop
Character

Controlled by the same setting of Code 39. No

Transmit Checksum Decide whether to include the checksum in the data being
transmitted.

Yes

Italian Pharmacode (= Code 32) Disable

*Transmit Start/Stop
Character

Controlled by the same setting of Code 39. No

Transmit Checksum Decide whether to include the checksum in the data being
transmitted.

Yes

Code 39 Enable

Transmit Start/Stop
Character

Decide whether to include the start/stop characters "*" in
the data being transmitted.

No

Verify Checksum Decide whether to verify the checksum. If the checksum is
incorrect, the barcode will not be accepted.

No

Transmit Checksum Decide whether to include the checksum in the data being
transmitted.

Yes

Code 39 Full ASCII Code 39 Full ASCII includes all the alphanumeric and
special characters.

No

Code 93 Enable

MSI Disable

Verify Checksum Select one of the three calculation formulas to verify the
checksum. If the checksum is incorrect, the barcode will
not be accepted.

 Single Modulo 10

 Double Modulo 10

 Modulo 11 & 10

Single Modulo
10
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Transmit Checksum Decide whether to include the checksum in the data being
transmitted.

 Last digit not transmitted

 Both digits transmitted

 Both digits not transmitted

Both digits
transmitted

Select Length  One or two fixed lengths

 Range

0~127

Negative Barcode Disable

Plessey Disable

Convert to UK Plessey When applied, each occurrence of the character "A" in the
barcode data will be replaced by the character "X".

No

Transmit Checksum Decide whether to include the checksum (2 digits) in the
data being transmitted.

Yes

Telepen Disable

Original Telepen
(Numeric)

The original Telepen includes numeric characters. Yes

AIM Telepen (Full
ASCII)

AIM Telepen (Full ASCII) includes all the alphanumeric and
special characters.

No

GS1 Databar-14/Expanded Disable

GS1
Databar-14

Transmit
Code ID

Decide whether to include Code ID ("]e0") will be included
in the data being transmitted.

Yes

GS1
Databar
Expanded

Transmit
Code ID

Refer to GS1 Databar -14.

Transmit Application
ID

Decide whether to include the Application ID ("01") in the
data being transmitted.

Yes

Transmit Checksum Decide whether to include the checksum in the data being
transmitted.

Yes

GS1 Databar Limited Disable

Transmit Code ID Refer to GS1 Databar -14. Yes

Transmit Application
ID

Refer to GS1 Databar -14. Yes

Transmit Checksum Refer to GS1 Databar -14. Yes

EAN-8 Enable

Convert to EAN-13 The EAN-8 barcode will be expanded into EAN-13, and the
next processing will follow the settings configured for
EAN-13.

No

Transmit Checksum Decide whether to include the checksum in the data being
transmitted.

Yes

Addon 2 / Addon 5 Decide whether to decode EAN-8 with supplementals. No

EAN-13 & UPC-A Enable
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ISBN Conversion The EAN-13 barcode starting with 978 and 979 will be
converted to ISBN.

No

ISSN Conversion The EAN-13 barcode starting with 977 will be converted to
ISSN.

No

GTIN for EAN-13 The EAN-13 barcode will be expanded into 14-digit Global
Trade Item Number (GTIN).

No

Transmit Checksum Decide whether to include the checksum in the data being
transmitted.

Yes

Addon 2 / Addon 5 Decide whether to decode EAN-13/UPC-A with
supplementals.

No

(UPC-A) Convert to
EAN-13

The UPC-A barcode will be expanded into EAN-13, and the
next processing will follow the settings configured for
EAN-13.

Yes

(UPC-A) Transmit
Checksum

Decide whether to include the UPC-A checksum in the data
being transmitted.

Yes

(UPC-A) Transmit
System Number

Decide whether to include the UPC-A System Number in
the data being transmitted.

Yes

UPC-E Enable

Convert to UPC-A The UPC-E barcode will be expanded into UPC-A, and the
next processing will follow the settings configured for
UPC-A.

No

Transmit Checksum Decide whether to include the UPC-E checksum in the data
being transmitted.

Yes

Transmit System
Number

Decide whether to include the UPC-E System Number in
the data being transmitted.

No

Addon 2 / Addon 5 Decide whether to decode UPC-E with supplementals. No

*It cannot read UPC-E1 barcodes!
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The tables below list reader settings as well as symbology settings for the Long Range
Laser (LR) or Extra Long Range Laser (ELR) scan engine.

READER SETTINGS TABLE

LR/ELR Description Default

AIM Duration  0~255, in units of 1 second.

 Enter 0 if aiming is not desired.

No aiming

Decode Time-out Set the maximum time for decoding to continue during a
scan attempt.

 5~99, in units of 0.1 second.

3.0 sec.

SYMBOLOGY SETTINGS TABLE

LR/ELR/2D Description Default

Codabar Disable

CLSI Editing When applied, the CLSI editing strips the start/stop
characters and inserts a space after the first, fifth, and
tenth characters of a 14-character Codabar barcode.

 The 14-character barcode length does not include
start/stop characters.

No

NOTIS Editing Decide whether to include the start/stop characters in the
data being transmitted.

 NOTIS Editing is to strip the start/stop characters, i.e.
to disable "Transmit Start/Stop Characters".

No

Select Length  Any Length

 One or two fixed lengths

 Range (1~55)

Any Length

Code 128 Enable

GS1-128 Enable

Field Separator Decide whether to replace the field separator. No

ISBT 128 Enable

Industrial 25 (= Discrete 25) Enable

Select Length  Any Length

 One or two fixed lengths

 Range (1~55)

Any Length

Appendix III
LR/ELR LASER SCAN ENGINE
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Interleaved 25 Enable

Convert to EAN-13 Convert a 14-character barcode into EAN-13 if the
following requirements are met:

 The barcode must have a leading 0 and a valid EAN-13
check digit.

No

Verify Checksum Decide whether to verify the checksum. If desired, select
one of the algorithms below. If the checksum is incorrect,
the barcode will not be accepted.

 No

 USS algorithm

 OPCC algorithm

No

Transmit Checksum Decide whether to include the checksum in the data being
transmitted.

 "Verify Checksum" must be enabled so that the
checksum can be left out (= "Transmit Checksum"
disabled).

No

Select Length  Any Length

 One or two fixed lengths

 Range (1~55)

Any Length

Code 39 Enable

Convert to Code 32 Convert to Italian Pharmacode. No

Code 32 Prefix Prefix character "A" to Code 32 barcodes. No

Verify Checksum Decide whether to verify the checksum. If the checksum is
incorrect, the barcode will not be accepted.

No

Transmit Checksum Decide whether to include the checksum in the data being
transmitted.

 "Verify Checksum" must be enabled so that the
checksum can be left out (= "Transmit Checksum"
disabled).

No

Code 39 Full ASCII Code 39 Full ASCII includes all the alphanumeric and
special characters.

Disable

Select Length  Any Length

 One or two fixed lengths

 Range (1~55)

Any Length

Trioptic Code 39 Disable

Code 93 Disable

Select Length  Any Length

 One or two fixed lengths

 Range (1~55)

Any Length

MSI Disable
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Verify Checksum If Two Check Digits option is selected, an additional
verification is required to ensure integrity. Select one of
the algorithms below. If the checksum is incorrect, the
barcode will not be accepted.

Check Digit Algorithm

One Check Digit Single Modulo 10

Two Check Digits  Mod 10/Mod 11

 Mod 10/Mod 10

Single Modulo
10

Transmit Checksum Decide whether to include the checksum in the data being
transmitted.

No

Select Length  Any Length

 One or two fixed lengths

 Range (1~55)

Any Length

GS1 Databar ---

GS1 Databar -14 "Convert to UPC/EAN" only applies to GS1 Databar -14 and
GS1 Databar Limited barcodes not decoded as part of a
Composite barcode.

Convert to EAN-13

Strip the leading "010" from barcodes.

 "01" is the Application ID and must be followed by a
single zero (the first digit encoded)

Convert to UPC-A

Strip the leading "0100" from barcodes.

 "01" is the Application ID and must be followed by
two or more zeros (but not six zeros)

Enable

GS1 Databar Limited Enable

GS1 Databar Expanded Enable

Covnert RSS to
UPC/EAN

No

EAN-8 Enable

Convert to EAN-13 The EAN-8 barcode will be expanded into EAN-13, and the
next processing will follow the settings configured for
EAN-13.

No

Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.

EAN-13 Enable

Bookland EAN (=
ISBN)

The EAN-13 barcode starting with 978 will be converted to
ISBN.

No

Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.

UPC-A Enable

Transmit Checksum Decide whether to include the UPC-A checksum in the data
being transmitted.

Yes

Transmit Preamble Decide whether to include the UPC-A preamble System
Number (and Country Code) in the data being transmitted.

System
Number

Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.



74

FORGE Batch Application Generator User Guide

UPC-E0 Enable

Transmit Checksum Decide whether to include the UPC-E0 checksum in the
data being transmitted.

Yes

Transmit Preamble Decide whether to include the UPC-E0 preamble System
Number (and Country Code) in the data being transmitted.

System
Number

Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.

Convert to UPC-A The UPC-E0 barcode will be expanded into UPC-A, and the
next processing will follow the settings configured for
UPC-A.

No

UPC-E1 Disable

Transmit Checksum Decide whether to include the UPC-E1 checksum in the
data being transmitted.

Yes

Transmit Preamble Decide whether to include the UPC-E1 preamble System
Number (and Country Code) in the data being transmitted.

System
Number

Addon 2 / Addon 5 Refer to UPC/EAN Addon setting.

Convert to UPC-A The UPC-E1 barcode will be expanded into UPC-A, and the
next processing will follow the settings configured for
UPC-A.

No

UCC Coupon Extended Code Disable

Read UPC-A barcodes starting with digit "5", EAN-13 barcodes starting with digits "99", and
UPC-A/GS1-128 Coupon Codes.

 UPC-A, EAN-13, and GS1-128 must be enabled first!

UPC/EAN Addon ---

Addon 2 / Addon 5 Decide whether to decode EAN-8, EAN-13, UPC-E0,
UPC-E1, UPC-A with supplementals.

 Ignore Supplementals

 Decode Only With Supplementals

 Decode With Supplementals (= Auto-discriminate)

Ignore...

Addon Redundancy When "Decode with Supplementals" is applied, decide the
number of times of supplementary decoding the same
barcode that makes a valid reading.

10 times
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The tables below list reader settings as well as symbology settings for the 2D scan
engine.

READER SETTINGS TABLE

2D Description Default

Focus Mode Select the focus mode to control the working range:

 Far Focus – optimized to read at its far position

 Near Focus – optimized to read at its near position

 Smart Focus – toggles the focus position after every
frame

Far Focus

Decode Illumination Decide whether to flash illumination on every barcode
capture to aid decoding.

 Turn On (Internal LED )

 Turn Off

On

AIM Pattern Decide whether to project the aim pattern during barcode
capture.

 Turn On

 Turn Off

On

Decode Time-out Set the maximum time for decoding to continue during a
scan attempt.

 5~99, in units of 0.1 second.

9.9 sec.

SYMBOLOGY SETTINGS TABLE

The symbology settings for the LR/ELR scan engine are all supported on the 2D scan engine. In
addition, the 2D scan engine supports the following symbology settings:

2D Description Default

Code 11 Disable

Verify Checksum Decide whether to verify the checksum. If the checksum is
incorrect, the barcode will not be accepted.

 No verification

 One Check Digit

 Two Check Digits

No

Appendix IV
2D SCAN ENGINE
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Transmit Checksum Decide whether to include the checksum in the data being
transmitted.

 "Verify Checksum" must be enabled so that the
checksum can be left out (= "Transmit Checksum"
disabled).

No

Select Length  Any Length

 One or two fixed lengths

 Range (1~55)

Any Length

Postal Codes ---

US Postnet Enable

US Planet Enable

Transmit US Postal
Checksum

US Postnet or US Planet must be enabled first! Enable

UK Postal Enable

Transmit UK Postal
Checksum

UK Postal must be enabled first! Enable

Japan Postal Enable

Australian Postal Enable

Dutch Postal Enable

Composite Codes Disable

Composite CC-C Disable

Composite CC-A/B Disable

Composite TLC-39 Disable

GS1 Databar Code 128
Emulation Mode

Transmit data as if it was encoded in Code 128 barcodes.

 Transmit AIM Code Identifier must be enabled first!

Disable

UPC Composite Mode UPC barcodes can be "linked" with a 2D barcode during
transmission as if they were one barcode.

UPC Never Linked

Transmit UPC barcodes regardless of whether a 2D
barcode is detected.

UPC Always Linked

Transmit UPC barcodes and the 2D portion. If the 2D
portion is not detected, the UPC barcode will not be
transmitted.

 CC-A/B or CC-C must be enabled!

UPC Never
Linked

Auto-discriminate UPC Composites

Transmit UPC barcodes as well as the 2D portion if
present.

2D Symbologies ---
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PDF417 Enable

MicroPDF417 Disable

MicroPDF417 Code 128
Emulation

Transmit data from certain MicroPDF417 barcodes as if it
was encoded in Code 128 barcodes.

 Transmit AIM Code Identifier must be enabled first!

When applied, the MicroPDF417 barcodes are transmitted
with one of these prefixes:

The first codeword of MicroPDF417 is 903-907, 912,
914, 915:

The original Code ID "]L3" will be changed to "]C1".

The first codeword of MicroPDF417 is 908 or 909:

The original Code ID "]L4" will be changed to "]C2".

The first codeword of MicroPDF417 is 910 or 911:

The original Code ID "]L5" will be changed to "]C0".

Disable

Data Matrix Enable

Maxicode Enable

QR Code Enable

2D Symbologies - Macro PDF ---

Macro PDF is a special feature for concatenating multiple PDF barcodes into one file, known as
Macro PDF417 or Macro MicroPDF417.

Transmit/Decode Mode Decide how to handle Macro PDF decoding.

Buffer All Symbols / Transmit Macro PDF When
Complete

Transmit all decoded data from an entire Macro PDF
sequence only when the entire sequence is scanned and
decoded. If the decoded data exceeds the limit of 50
symbols, no transmission because the entire sequence
was not scanned!

 The transmission of the control header must be
disabled.

Passthrough
All Symbols
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Transmit/Decode Mode
Transmit Any Symbol in Set / No Particular Order

Transmit data from each Macro PDF symbol as decoded,
regardless of the sequence.

 The transmission of the control header must be
enabled.

Passthrough All Symbols

Transmit and decode all Macro PDF symbols and
perform no processing. In this mode, the host is
responsible for detecting and parsing the Macro PDF
sequences.

Send Control Header The control header contains the segment index and file ID.
This option has no effect when "Passthrough All Symbols"
is applied.

Yes

ESC Characters When enabled, it uses the backslash "\" as an Escape
character for systems that can process transmissions
containing special data sequences. It will format special
data according to the Global Label Identifier (GLI)
protocol, which only affects the data portion of a Macro
PDF symbol transmission. The Control Header, if enabled,
is always sent with GLI formatting.

None

Note: When printing barcodes, keep each Macro PDF sequence separate, as each has a
unique identifier. Do not mix barcodes from several Macro PDF sequences, even if
they encode the same data. When you scan Macro PDF sequences, scan the entire
Macro PDF sequence without interruption!


